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Preface
Preface
This document consists of a User Manual for Task Coach Version 1.4.6. This manual is intended for both 
beginners and experienced users of the Task Coach software system. While every precaution has been 
taken in the development of the software and in the preparation of this documentation, Task Coach 
assumes no responsibility for errors or omissions, or for damage resulting from the use of the software or 
of the information contained herein. 

Task Coach version 1.4.6 is an open ended free to use software, this documentation is also free to use and 
download, but however changing this User Manual in any way is not permitted. 

Task Coach is a free open-source task manager that helps to prioritize to do tasks. The different functions 
of Task Coach include but not limited to prerequisites, prioritizing, effort tracking, category tags, budgets, 
notes, and complex, combined tasks. Task Coach can be customized as per end user requirements and is 
available for download on multiple platforms including Windows, Mac OS and Linux. 

About this Manual 

Task Coach Version 1.4.6 user manual describes how to install, configure and using the different functions 
in the software. The following sections gives an overview of the content that is explored in this User Man-
ual. 

Installing Task Coach Version 1.4.6

This section covers the installation process along with the hardware and software requirements required 
for installing Task Coach Version 1.4.6. 

Getting Started with Task Coach Version 1.4.6

The Instructions chapter covers the functions that Task Coach offers and how users can customize the 
functions to match their requirements.

Troubleshooting for Task Coach Version 1.4.6

The troubleshooting section in this manual is intended to give the user information on how to solve and 
prevent potential problems that may arise when using Task Coach Version 1.4.6.

Frequently Asked Questions (FAQs)

This section covers some of the Frequently asked Questions (FAQs) about using Task Coach and a list of 
useful tips.

Appendix A: Reference List of Tables

This section covers the list of tables that are used in this user manual.

Appendix B: Reference List of Figures

This section covers the list of figures that are used in this user manual.

Index 

The Index contains an alphabetical list of all the keywords that have been used in this manual. The key-
words will also be hyperlinked in order to take the user to the word.
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Installing Task Coach Version 1.4.6
Chapter 1: Installing Task Coach Version 1.4.6
This section covers the installation process along with the hardware and software requirements required 
for installing Task Coach Version 1.4.6. The installation process for different Operating Systems are out-
lined in the sections below.

Installing Task Coach on Windows

The installer will guide you through the installation process. 
Define a location for your tasks folder.
To download Task Coach on Windows; See “Installing on Windows” on page 1.

Table 1.1:Installing on Windows

Note: In the event that you are migrating from one Windows device to another, you just need the tasks folder to 

migrate to a new device.

Installing Task Coach on Mac OS

The installer for Mac OS is included in the disk image file (.dmg). After downloading the file, click and drag 
the app to the applications folder. 
To install Task Coach on Mac OS; See “Installing on Mac OS” on page 1.

Table 1.2:Installing on Mac OS

Description Specifications

Versions All versions of Windows are supported.

System Requirements None.

Download For downloading the installer, please click 
here

Installation Run the Installer, it will guide you through the 
installation process.

Description Specifications

Versions All versions of Mac OS X Leopard/10.5 (Uni-
versal) and newer are supported.

System Requirements None.

Download For downloading the installer, please click 
here

Installation Run the disk image file (.dmg), it will guide 
you through the installation process.
1
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Installing Task Coach on Linux

The installer for Linux is included in the executable file. After downloading the file; open the file, make it 
executable and launch it. 
To download Task Coach on Linux; See “Installing on Linux” on page 2.

Table 1.3:Installing on Linux

Description Specifications

Versions All versions of Linux are supported.

System Requirements None.

Download For downloading the executable file, please 
click here

Installation Make the file executable, and launch it.
2
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Getting Started with Task Coach Version 1.4.6
Chapter 2: Getting Started with Task Coach Version 1.4.6

Task Coach Version 1.4.6 is a hierarchical based Task management software, developed using Python. This 
chapter explains how to get started with Task Coach. It aims to give you an explanation and a guide to the 
functions of Task Coach Version 1.4.6. 

Opening Task Coach

When you open Task Coach for the first time, you will see the Tasks viewer as shown in Figure 2.1. The 
fields displayed are the customisable default fields. You can use Task Coach to keep track of personal Tasks 
and to do lists. 
See “Opening Task Coach” on page 3, for when you open Task Coach.

Figure 2.1:Opening Task Coach

Creating a Task

To start, you will have to create a new Task.
To create a new Task.

1. Click New Task             in the top left corner of the screen.

A dialog box will start up with the information for setting up a new Task.

1.Name your New Task.

2.Enter a Description of the Task.

3.Click Close on the bottom right corner of the dialog box.
3
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Customize the following parameters in the new Task pop-up.

•Description

•Dates

• Prerequisites

•Progress

•Categories

•Budget

•Effort

•Notes

•Attachments. See “Setting up a new Task” on page 4. 

Figure 2.2:Setting up a new Task
4
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Editing a Task

Any information in a Task, can be changed or edited as per your preference.
To Edit a Task.

1.Right click the Task.

2.Click the Edit on the pop-up menu.

3.Select the parameter that you would like to edit, the parameters are the same as previously. 
described in Creating a Task.

Marking a Task complete

A Task can be marked complete after finishing it.
To Mark a Task Complete.

1.Right click the Task.

2.Click the Mark Task Complete on the pop-up menu. (See “Marking a Task complete” on page 5)

Figure 2.3:Marking a Task complete
5
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Saving a Task

You must Save new Tasks or newly edited Tasks or you will lose information related to the Task file.
To Save a Task.

1.Click File on the top left corner of the menu bar.

2.Click Save.

3.Select the location you want to save the file.

4.Name the file.

5.Click Save.

Note: You use the keyboard shortcut for saving your work, press CTRL +S for an automatic save.

If you would like to save the file you are working in a different location, click Save As, select the file loca-
tion and the new name for the file.

Note: The keyboard shortcut for Save As is CTRL +SHIFT+S.

Task coach files are always saved with a.tsk file extension, which is an XML file. See ““Saving a Task Coach 
file” on page 6.

Figure 2.4: Saving a Task Coach file
6
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Closing a Task File

A Task File can be closed after working on it.
To Close a Task file.

1.Click File on the top left corner of the menu bar.

2.Click Close.

Deleting a Task

A Task File can be deleted after it is no longer required.
To Delete a Task.

1.Right click the Task you would like to delete.

2.Click Delete.

Alternatively, click            in the tool bar. 

Note: When a Task is deleted; any subtasks, attachments, or categories linked to the Task will also get 
deleted.

Managing the Back ups of Tasks Files

Every time you save a file, a copy is automatically backed up. To access the backup copies of your files, 
refer to the following steps
To Manage Back ups of Task Files.

1.Click File in the top right of the tool bar.

2.Click Manage Back Ups.

3.In the back up pop-up window, select the version of the file you need. See“How to manage back‐
ups” on page 8
7
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Figure 2.5: How to manage backups

Setting Categories for Tasks

You can organize your Tasks into specific Categories. A Task can have as many categories as you want, and 
categories can have further sub-categories. Categories offer additional filtering when viewing Tasks.
You can create categories and sub-categories that can be assigned to Tasks and notes.
To set a Category.

1.Double click the Task you want to add categories to.

2.On the pop-up window select Categories tab.

3.Double click New Categories and make a new Category. See “How to set Categories” on page 9.
8



Getting Started with Task Coach Version 1.4.6
Figure 2.6:How to set Categories

Deleting a Category

You can delete a Category after completing it or midway through the Category. 
To Delete a a Category, please see the following steps.

1.Double click the selected Task.

2.Select the Categories tab In the pop-up window.

3.Select the Category and then Right Click.

4.Click the Delete option.

The second way to delete a category, click                icon in the tool bar.

Note: When a Category is deleted; any sub task, item, or attachment linked to the Category will also get 
deleted.
9
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Budgeting a Task

You can establish a Budget for a Task by referring to the following steps.
To set up a Budget.

1.Double click the Task.

2.Select the budget tab from the dialogue box.

3.Select and change the budget parameters from the dialogue box. See “How to set a budget” on 
page 10“

Figure 2.7: How to set a budget

Creating Notes in Task Coach

You can create Notes in Task Coach and link it to any Task or category. 
You can also create Notes independent of any item. Attachments can also be attached to notes.
To Create a Note.

1.Click New in the tool bar.

2.Click New Note.

Note: You can view Independent Notes in the Notes viewer; notes linked to Tasks and categories will not 
appear in the Notes viewer.
10
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Setting Preferences in Task Coach

You can customise a Preferences in Task Coach by setting specific preferences to it.
To access Preferences and customise it, follow the steps outlined below.
To set Preferences in Task Coach.

1.Click Edit in tool bar.

2.On the preferences pop-up window, select the Preference Parameter and start making changes. See 
“How to set Preferences” on page 11”.

Figure 2.8:How to set Preferences

You can customise the Preferences in the dialog box to the following.

•Window Behavior

•Files

•Language

•Task Dates

•Task Reminders

•Task Appearance

•Task Features

•Features
11
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•Editor

Setting Reminders for Tasks

A reminder can set on Tasks.
To set a Reminder, please see the following steps.

1.Open a New Task or the Edit Task option.

2.On the Date tab, click the dialog box for reminder.

3.Select the date and time for the reminder.

When the reminder pop-up page appears, you can choose the following from the Snooze options:

•Don’t snooze

•10 minutes

•15 minutes

•30 minutes

•1 hour

•2 hours

•24 hours

Printing on Task Coach

Task Coach can print a complete list of Tasks and Categories. Any information displayed on the viewer 
panel will be printed.
To Print on Task Coach.

1.Click File in the top right of the tool bar.

2.Click the Printer           symbol in the drop-down menu.

3.Select your Printer from the list of options.

4.Select Print.
12
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Exporting Task Coach files

You can Export Task Coach files in different formats to other devices. 
To Export Task Coach files.

1.Click File in the top right of the tool bar.

2.Click Export.

3.Choose between 1 of 4 Export formats: 

•HTML

• CSV

•iCalendar

•Todo.txt

Importing Task Coach files

You can Import Task Coach files in different formats to other devices. 
To Import Task Coach files.

1.Click File in the top left of the toolbar.

2.Click Import.

3.Select the location of the file to be Imported.

Effort tracking on Task Coach

You can track the time (Effort) spent on any given Task.
To Effort Track on Task Coach.

1.Double click the selected Task.

2.Select the Effort tab In the dialog box.

3.Click New Effort             in the top left corner of the dialog box. See “How to track effort” on page 14.
13
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Figure 2.9:How to track effort

Changing the Appearance of Tasks

You can change the Appearance of Tasks to suit your preference. 
To Change the Appearance of a Task.

1.Double click the selected Task.

2.Select the Appearance tab In the dialog box.

3.You can customize the following options to change the appearance.

•Foreground colour

•Background colour

•Font

•Icon. See “How to change the appearance of tasks” on page 15”.
14
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Figure 2.10:How to change the appearance of tasks
15
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Chapter 3: Troubleshooting for Task Coach Version 1.4.6

Please refer to the following sections, in case you need support for Task Coach Version 1.4.6.

Home Page

Task coach has a web page that can be accessed for licensing and support information.
https://www.taskcoach.org

Further information can also be found on 
https://sourceforge.net/projects/taskcoach/

Requesting support for Task Coach

To submit a Support Request, click on the following link 
https://sourceforge.net/p/taskcoach/support-requests/

Please include the following information in your email.

•The Task Coach Version you are using.

•The Operating System you are using.

•The issue that you are facing.

Reporting a bug on Task Coach

To Report a Bug on Task Coach, click on the following link:
https://sourceforge.net/p/taskcoach/bugs/
Please include the following in your email

•The Task Coach Version you are using.

•The Operating System you are using.

•The issue that you are facing.

Requesting a Feature for Task Coach

To Submit a Request for a new feature.
https://taskcoach.uservoice.com/forums/26465-desktop-version-windows-linux-mac-of-task-coach
Please note that Task Coach is a free to use software and due to the high number of new requests, we 
entertain those requests that are feasible and no guarantees can be made as to whether the requests will 
be added.
17

https://www.taskcoach.org
https://taskcoach.uservoice.com/forums/26465-desktop-version-windows-linux-mac-of-task-coach
https://sourceforge.net/p/taskcoach/support-requests/


Task Coach User Manual Version 1.4.6
18



Frequently Asked Questions (FAQs)
Chapter 4: Frequently Asked Questions (FAQs) 

Email Integration with Task Coach

Does Task Coach integrate with Mail apps?
Yes, Task Coach can be integrated with Outlook.
To Email a Task.

Can a single Task be emailed?

1.Right click Task.

2.Select Email.

3.Enter the email address, you want to send the Task to.

4.Click Finish.

Can a multiple Tasks be emailed?

1.Use Ctrl + Shift to select Multiple Tasks.

2.Right click and select Email.

3.Enter the email address, you want to send the Task to.

4.Click Finish.

Using different languages with Task Coach

Coach can be run in a number of selected languages.
To select any other language.

1.Click Edit > Preferences.

2.Select the Language from the drop-down list.

3.Restart Task Coach after selecting the Language you would like to choose.

Currently Task Coach has only a limited number of language selections.

Using different colours for different Tasks

You can use different Colours for different Tasks.
To use colours for Tasks, please see the following steps.

1.Click Edit > Preferences.

2.Click Task Appearance tab.
19 



Task Coach User Manual Version 1.4.6
The colours are currently default in Task Coach, see “Colours and corresponding Task descriptions” on 
page 20.

Table 4.1: Colours and corresponding Task descriptions

Keyboard Shortcuts for Task Coach

Please note that this list is not an extensive list but rather a list of the more commonly used shortcuts.
Task Coach uses the same keyboard shortcuts that Windows use.
To use keyboard shortcuts, See “Keyboard Shortcuts” on page 20.

Table 4.2: Keyboard Shortcuts

Description Colour Indication

Inactive Task Grey

Late Task Purple

Active Task Black

Due Soon Task Orange

Overdue Task Red

Completed Task Green

Description Shortcut Description Shortcut 

Cut Ctrl + X Changing Date Ctrl + I

Copy Ctrl + C New Sub Task Ctrl + Ins

Paste Ctrl + V Scrolling between tabs Ctrl + PgUp

Save Ctrl + S Marking a Task complete Ctrl + Enter

Save as Ctrl + Shift +S Deleting a Task Ctrl + Del

Open Ctrl + O Page set up Shift + Ctrl + P

Closing Task Coach Ctrl + W Preferences Alt + P

Undo Ctrl +Z Start Tracking Ctrl + T

Redo Ctrl + Y Add Attachment Shift + Ctrl + A

Adding Notes Ctrl + B Help Ctrl + H
20
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Running Task Coach from External Devices

Task Coach can be run from external devices like a usb or an external hard drive. 
To run Task Coach from an External Device.

1.Install Task Coach directly on the external device.

2.Change the preferences (Edit > Preferences).

3.Select the File tab.

4.Select the Save Setting (TaskCoach.ini) in the same directory as the program.

Upgrading to a newer version of Task Coach

You can always upgrade to the latest version of Task Coach.
To upgrade to a newer version of Task Coach, please see the following steps.

1.Uninstall the version of Task Coach, currently on your OS.

2.Download the latest version of Task Coach and install it.

Editing by multiple users

Currently Task Coach cannot be edited by multiple users simultaneously. However, you can transfer the 
Task files to another external device that can be worked on multiple devices by multiple users.

Undoing & Redoing steps

You can Undo or Redo steps unlimited times.
To Undo or Redo a step.

1.To Undo a step, click the               icon.

2.To Redo a step, click the               icon.
21 
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